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Section 1 Specifications

1.1 Mechanical

Rated depth 350 m

Weight in air, water 4 kg, 1.5 kg

Length 71.1 cm

Material Plastic

1.1.1 Standard bulkhead connector
Contact Function MCBH-6-MP connector

1 Ground

2 RS232 RX

3 RS232 TX

4 SDI-12

5 Reserved

6 Voltage in

1.2 Electrical

Input 9–24 VDC

Current draw, operation 140 mA

Current draw, low power 30 µA

Current draw, communication 54 mA

Current draw, standby 46 mA

Linearity 99%

1.3 Communications

Data storage 16 Mb ~215000 samples

Communication interface RS232 or SDI-12 

RS232 output rate 600–115200 baud; 19200 default

SDI-12 output rate 1200 baud

1.4 Analytical

Parameter Range Initial Accuracy Stability Resolution

Conductivity 0–70 mS/cm ±0.003 mS/cm 0.003 mS/cm/mo 0.0001 mS/cm

Temperature -5–45 °C ±0.002 °C (-5–35 °C)
±0.01 °C (35–45 °C)

0.0002 °C/mo 0.0001 °C

Pressure 20, 100, 350 m ±0.1% full scale range 0.05% full scale range/yr 0.002% full scale
range
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Parameter Range Initial Accuracy Stability Resolution

Dissolved Oxygen 200% surface
saturation

±0.2 mg/L or ±2%,
whichever is greater

<0.03 ml/L/100,000 samples
@20 °C

0.005 ml/L

pH 0–14 ±0.1 0.1/90 days 0.01

Parameter Range, Sensitivity Wavelength Initial Accuracy Resolution Linearity

Chlorophyll 0–400, 0.025 µg/L 470/695 nm ±3% signal
equivalent of
uranine

0.007–0.37 mg/L based on
range

99%

Turbidity 0–3000, 0.01 NTU 700 nm ±1% 0.006 (0–85 NTU)
0.033 (86–550 NTU)
0.17 (551–3000 NTU)

Specifications
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Section 2 Overview

The HydroCAT-EP measures conductivity (C), temperature (T) and pH with optional
capabilities to measure pressure (D), optical dissolved oxygen (DO), chlorophyll and
turbidity. The typical HydroCAT-EP includes all of the above. The sensor is designed for
moored and other long-term, fixed-site deployments. It has an integrated pump that
operates each time the sensor collects a sample. Each sample takes 38 seconds plus the
user-specified pump operation time. The integrated pump has advantages over sensors
without pumps—

• The pump flushes the sampled water and quickly moves a new sample into the flow
path so that conductivity and oxygen measurements are more accurate.

• Water does not flow freely through the flow path so it stays saturated with the anti-
fouling chemicals.

• The optical DO sensor is integrated in the flow path for better correlation with the
CTD measurement.

The user can operate the sensor in an autonomous or controlled (polled) mode.
Autonomous operation

• RS232 
• Can use internal or external power.
• Can transmit data in real-time.
• Can transmit the last sample stored internally while in autonomous operation.
• Operation sequence:

1. The pump operates
2. The sensor measures C, T, D, and DO
3. The pump stops
4. The sensor measures fluorescence, turbidity, and pH
5. The data is stored internally
6. The sensor goes into a low power mode until the next user-defined sample time.

Controlled operation

• RS232 or SDI-12 
• RS232 can use internal or external power. SDI-12 uses external power only.
• Operation sequence:

1. The pump operates
2. The sensor measures C, T, D, and DO
3. The pump stops
4. The sensor measures fluorescence, turbidity, and pH
5. The sensor sends the data to the controller
6. The sensor goes into a low power mode until the next user-defined sample time.
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The image above shows the components and the flow path of the HydroCAT-EP with the
cell guard and anti-fouling covers removed. Note that the fluorescence and turbidity
sensor is not in the pumped flow path.

Overview

6



Section 3 Set up for operation

3.1 Install batteries
The manufacturer ships the twelve lithium batteries for the sensor separately. Do the
steps below to install or replace the batteries.

Table 1  Recommended lithium battery brands

SAFT LS-14500 (included) 3.6 V, 2.6 Ah

Tadiran TL-4903 3.6 V, 2.4 Ah

Electrochem BCX85 Series 3.9 V, 2.0 Ah

1. Make sure that the end flange and pressure housing are dry.
2. Use a 9/64" hex key to remove the two screws on the sides of the pressure housing.
3. Turn the end flange counter-clockwise to loosen it from the pressure housing.

4. Pull gently to disconnect the battery wires in the end flange from the battery pack.
5. Use a lint-free tissue to remove any water from the O-ring surfaces inside the

pressure housing and end flange.
6. Use a 7/64" hex key to loosen the captured screw in the battery cover plate.
7. Remove the battery pack from the pressure housing.
8. Turn the yellow cover plate counterclockwise to remove it from the battery pack body.
9. Remove the two O-rings on the outside of the battery pack.

Keep these O-rings to use again.
10. Examine the O-rings and surfaces for dirt, cuts, or other damage.

Clean or replace as necessary.
11. If necessary, remove the batteries in the pack.
12. Make sure to alternate the positive (+) and the negative (-) ends on the batteries to

agree with the labels on the pack as they are installed.
13. Apply a small quantity of Parker Super O Lube® to the new O-rings.

The lubricant helps the O-ring move into its groove with no twist, which can
compromise the seal.

14. Install the O-rings onto the battery pack.
15. Align the pin on the yellow battery cover with the post hole in the battery pack

assembly.
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16. Align the "D"-shaped part of the battery pack with the pins on the shaft.
17. Slowly move the assembly onto the housing. Push gently to connect the battery

assembly with the circuit board in the pressure housing.
18. Use a 7/64" hex key to tighten the screw on the yellow battery cover onto the shaft in

the pressure housing.
19. Attach the Molex connector on the end flange to the connector in the pressure

housing.

20. Examine the O-rings and surfaces for dirt, cuts, or other damage. Clean or replace as
necessary.

• Apply a small quantity of Parker Super O Lube® to any new O-rings.
21. Carefully push the end flange into the pressure housing.

It may help to rotate the end flange so that the wires do not bend too much.
22. Use a 9/64" hex key to install the two screws into the end flange.

3.2 Install anti-fouling devices
New sensors have two anti-fouling devices and a yellow protective label installed by the
manufacturer.

C A U T I O N
 

Make sure to remove the label before the sensor is deployed or pressurized or the conductivity
cell can be damaged.

1. Remove the yellow label.

• The user can make sure the anti-fouling devices are installed: refer to section
about Remove or replace anti-fouling devices on page 28 for details.

2. Keep the label to attach again to protect the intake and exhaust ports when the
sensor is not deployed.

Set up for operation
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3.3 Install pH sensor

N O T I C E
 

The pH sensor must be kept wet. Fill the flow path on the instrument with fresh (not de-ionized)
water between deployments, or remove the pH sensor and store it in the white KCl cap.

The pH sensor for the HydroCAT-EP ships separately in a white cap that is filled with potassium
chloride (KCl) solution to keep the glass bulb and reference electrode wet. The user must install
the pH sensor before the instrument is deployed to measure pH. Make sure to keep water and
dirt off of the connectors on the pH sensor.

1. Put a 3/32" hex key in the copper tube and loosen the screw that holds the pH sensor
or protective dummy connector (on new sensors) to the body of the HydroCat-EP.

2. Disconnect the pH sensor (or the dummy connector) from the main sensor body.
Keep the dummy connector.

3. Make sure that the white cap is below the pH sensor.
The KCl solution will spill out of the white cap if it is turned upside down.

4. Use a 3/32" hex key to loosen the screw on the bottom of the white cap that attaches
to the pH sensor.

Set up for operation
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5. Remove the pH sensor from the white cap and install it onto the HydroCAT-EP body.
6. Install the 3/32" screw in the copper tube of the sensor again.
7. Update the calibration coefficients that are stored in the main sensor.

3.4 Install and start software
The manufacturer-supplied software communicates with a number of sensors. Refer to
the manufacturer's website for the current list of sensors that use this software.
Make sure that the sensor is not connected to the USB port of the PC while the USB-
Serial driver is installed. The USB will not function correctly and communication errors will
occur.

1. Get the software from manufacturer's website or the manufacturer-supplied CD.
2. Install the appropriate software.

a. For Windows™: Double-click on the file with ".exe" appended to the name.
b. For Mac OS X: Double-click on the file with ".pkg" appended to the name. Make

sure that the default "Install for all users on this computer" is selected as the
destination for the installed software. If "Install for me only" or "Install on a
specific disk" is selected, the USB will not connect to the sensor.

3. Push Run in the new window.
The setup wizard starts.

4. Follow the on-screen instructions to install the software.

• It is only necessary to install the USB-to-Serial driver when the software is first
installed.

5. Connect the cable to the bulkhead connector on the sensor and to the PC.
6. If necessary, start the software.
7. Push Connect in the Dashboard area.
8. If necessary, change the "Instrument Type" to the connected sensor.
9. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
10. If necessary, select the communication port.
11. Push Connect.

The "Connection Mode" shows "Transition" on a yellow background, and then shows
"Setup" on a green background.

12. Select the UCI menu, then Preferences.
13. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

14. Push OK.

3.5 Configure software
Make sure that the sensor has new batteries installed or is connected to a power supply
(optional) or SDI-12 controller, and PC through the RS232 connector on the supplied
cable, and is on.
Most PCs no longer have RS232 "COM" ports so an RS232-to-USB converter is
necessary. Make sure that the USB driver software is installed on the PC so that there is
communication between the sensor and the PC.

Set up for operation
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3.6 Verify sensor operation
Make sure that the sensor has new batteries installed or is connected to a power supply
(optional) or SDI-12 controller, and PC through the RS232 connector on the supplied
cable, and is on.
Most PCs no longer have RS232 "COM" ports so an RS232-to-USB converter is
necessary. Make sure that the USB driver software is installed on the PC so that there is
communication between the sensor and the PC.
Do the steps below to make sure that the sensor operates, collects, and transfers data
with the settings selected by the user before further setup and deployment.

1. Connect the cable to the bulkhead connector on the sensor and to the PC.
2. If necessary, start the software.
3. Push Connect in the Dashboard area.
4. If necessary, change the "Instrument Type" to the connected sensor.
5. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
6. If necessary, select the communication port.
7. Push Connect.

The "Connection Mode" shows "Transition" on a yellow background, and then shows
"Setup" on a green background.

8. Select the UCI menu, then Preferences.
9. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

10. Push OK.

3.6.1 Set up output format
The parameters selected in this tab change the data that is moved to the PC and the data
that shows in the Real Time Display tab. Parameters that are not selected are still
collected and stored as data by the sensor but do not show in the Real Time Display tab.

1. Push Settings in the Dashboard area of the connected sensor.

Set up for operation
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2. On the Output Format tab: if necessary, change any of the Parameter Units.

Table 2  Parameter units

Temperature Celsius*, Fahrenheit

Conductivity uS/cm*, S/m, mS/cm

Pressure Decibar*, PSI

Oxygen mg/L*, ml/L

* default parameter
3. If necessary, change any of the Parameters to Output, or push Default to use the

manufacturer-set values.

Table 3  Parameters to output

Temperature* Salinity

Conductivity Sound velocity

Pressure* Specific conductivity*

Oxygen* Sample number

pH Chlorophyll

Turbidity

* default parameter
4. Push Apply to save the values in the sensor.

Set up for operation
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3.6.2 Set up data collection
Select the Data tab to set the interval at which the sensor collects data.

1. Select the Data tab to set the interval between samples.
The sensor collects data at the end of the specified interval.

2. Enter a value between 10–21600 seconds in the "Sample Interval" area.
3. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.

3.6.3 Set up pump operation
Select the Pumping tab to set the values for the operation of the pump. The software
automatically gets the Zero Conductivity Frequency and the Minimum Conductivity
Frequency values from the connected sensor and shows them in the Pumping tab. The
Minimum Conductivity Frequency value is the Zero Conductivity Frequency plus the offset
value for either salt water (500 Hz) or fresh water (1 Hz). This sum is the minimum
conductivity frequency at which the pump will operate.

1. If necessary, change the "Minimum Conductivity Frequency."

• If the sensor is set up to operate in an autonomous mode, the pump will operate
a "pre-flush" for a manufacturer-set default of 300 seconds before data is
collected. This removes air from the plumbing and primes the pump. The user
can enter a value from 300–600 seconds for the "Pre-flush Duration."

• If the sensor is set up to operate with a controller ("polled" mode), put a check in
the box next to " Scheduled Pre-flush for Polled Sampling." Make sure to set the
pre-flush cycle to complete before the sensor starts to collect data. Data
collection will cancel the pre-flush operation.
Select the "Start Date."
Select the "Start Time" (hours).

2. Push Apply.

Set up for operation
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3.6.4 Set up baud rate
It is not necessary to change the baud rate for deployment, but the user can set a faster
baud rate to transfer data after a deployment.
Available baud rates:

• 4800 
• 9600 
• 19200 HydroCAT, HydroCAT-EP default
• 38400 
• 57600 SUNA default
• 115200 

3.7 Verify sensor transfers data

C A U T I O N
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix new and
used cells or chemistries.

N O T I C E
 

Make sure that the sensor is connected to a power supply or has good batteries installed and is in
communication with the software.

1. Push Transfer Data in the Dashboard area.
The Transfer Data window shows.

• The Memory Summary lets the user estimate the available data storage in the
sensor. The "Sample Length" is sensor-specific and shows the length of each
data record that the sensor stores. Divide the "Free Samples" by "Sample
Length" for an estimate of how many more samples the sensor can store.

2. In the "Transfer Type" drop-down menu in the Data Transfer Options area, select
either "All Data" or "Scan Number Range."

• "All Data": all data stored in the sensor is transferred to the PC in both .csv
and .xml file types.

• "Scan Number Range": a user-specified range of samples is transferred in
both .csv and .xml file types. Select the specific samples in the Scan Range area.

Set up for operation
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Note that the "Number Scans" value is the total number of samples stored in the
sensor.

3. In the Output CSV Data File area, type a new filename or use the automatically
generated file name.

4. Optional: change the time stamp to UTC.
5. Push Transfer.

The data is copied to the PC.

• The default is a check in the box for "Display Data when Transfer Completed."
The user can remove the check so that data does not show in the Time Series
tab after it is saved to the PC.

6. Push OK when the Transfer Progress window shows 100%.
7. The sensor is ready to set up for a specific deployment.

Set up for operation
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Section 4 Verify sensor performance

To make sure that the sensor operates at optimum precision, the user must do various
checks and updates to the sensor at regular intervals. Use the software to do these
checks.

4.1 Temperature check
Use a sensor that has the same or better specification for accuracy of the unit under test
as a reference to validate the temperature stability. The manufacturer recommends that
the user does this check in a laboratory because the temperature of the water in the
temperature check bath must be stable. Pass criteria:

• data is within 0.2 °C of the reference sensor
• three data points are within 0.01 °C.

1. Put the sensor in a temperature-stable water bath as close as possible to the sensor
that is being used as a reference.

2. Let the sensors become stable for at least one hour, or more if there is a large
difference between the water and the room temperature. Make sure that the
temperature of the reference sensor is stable to within 0.05–0.1 °C.

3. Record the temperature of the water in which the sensor is submerged.
4. Push Temperature Check in the Dashboard area.
5. Push Next to start the check.
6. Enter the water temperature in °C in the "Temperature" area.
7. Push Start.

The software takes a few minutes to collect data for the test. The results show in the
"Status" area.

8. Push Next.
9. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

check information.
10. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
11. Push Finish.
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The Temperature Check window closes and the .pdf report shows if the "View" box
has a check in it.

4.2 Conductivity checks
The software lets the user do a check of the accuracy of the conductivity measurements
made by the HydroCAT and the HydroCAT-EP. This shows that the conductivity cell
operates within specifications. There are two conductivity checks:

1. Zero conductivity

N O T I C E
 

Do not blow canned air into the intake or exhaust ports to dry the conductivity cells. It causes
damage to the cells.

Make sure that the conductivity cell is clean and dry, then start the check.

• For the HydroCAT-EP, this value is stored in the sensor.
• For the HydroCAT, this value is on the manufacturer-supplied calibration page.

Pass criterion for sensor: 0.3 Hz of calibrated conductivity.
2. Conductivity of a user-supplied conductivity standard solution.

• Use enough solution to completely fill the flow path of the sensor.
• Do this check after the solution and the sensor are at ambient temperature.

Pass criterion for sensor: 0.02 mS/cm of standard solution.

4.2.1 Zero conductivity check
The conductivity cell must be clean and dry to do the zero conductivity check. Refer to 
Clean sensor flow paths on page 27 for details.

1. Remove the pH sensor if the flow path will be dry for more than 2 hours so that the
sensor does not dry out. Refer to Install or remove pH sensor on page 30 for
details.

2. Remove the anti-fouling assembly. Refer to Remove or replace anti-fouling devices
on page 28 for details

3. Push Conductivity Check in the Dashboard area.
4. Push Next to start the check.

Verify sensor performance
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5. At step 2, "Calibration Zero Conductivity Frequency Check":

• HydroCAT—enter the first value form the "INST FREQ" column on the
manufacturer-supplied calibration page.

• HydroCAT-EP—the software automatically enters this value from the sensor.
6. Push Start.

The software takes a few minutes to collect data for the test. The results show "Check
Complete" in the "Status" area when the test is complete. If the conductivity value is
within 1.0 Hz of the calibrated zero conductivity, the sensor passes.

• If the sensor fails the conductivity check, refer to Clean sensor flow paths
on page 27 for details on how to flush the flow path with Triton X-100™ solution
and then rinse with DI water. It may be necessary to flush the sensor several
times.

• Make sure that the conductivity cell is clean and dry, then push Start to do the
conductivity check again.

7. Push Next.
The software shows the steps to complete the check for the user-supplied
conductivity standard.

8. Push Next.
The software is ready to do the check of the sensor with the conductivity standard
solution.

4.2.2 Conductivity standard check
The manufacturer recommends that the user verifiy the sensor calibration before and
after a deployment or when the it has been in contaminated water.
Make sure that the sensor and the solution(s) are at the same stable temperature.
Supplies necessary to do the check:

• The manufacturer-supplied kit (P/N 50087.1) that has the necessary plumbing and
tools.

• 60 ml each of user-supplied conductivity standard solutions for calibration.
• 500 ml bottle of DI water
• Container for the sensor
• Container for waste water

Make sure that the output values of the sensor agree with a user-specified standard
solution.

1. Remove the anti-fouling assembly from the sensor if necessary. Refer to Remove or
replace anti-fouling devices on page 28 for details.

2. Flush the sensor with DI water.

a. Put the sensor in a container.

Verify sensor performance
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b. Attach a 10 cm length of tubing to either the intake or exhaust port of the sensor.
c. Attach a length of tubing to the syringe.
d. Pull approximately 30 ml of DI water into the syringe.
e. Attach the syringe and tubing to either the intake or the exhaust port of the

sensor.

f. Push the syringe plunger to fill the sensor until 3–5 cm of solution shows in each
tube.

g. Push and pull the syringe plunger until there are no bubbles in the tubing.
h. Remove the sensor from the container and drain the fluid in the sensor into a

waste container. Push the syringe plunger to help remove all of the fluid from the
sensor.

i. Remove the tubing and shake the sensor.

Verify sensor performance

20



The sensor is ready for a functional test in the laboratory, or for a deployment.
3. Flush the flow path of the sensor with the solution that will be used to test the output

of the sensor (step 2 A–H).
4. Fill the flow path of the sensor with the conductivity standard solution (step 2 A–F).
5. Enter the value of the conductivity standard in step 4 of the Conductivity Check.
6. Push Start.

The software takes a few minutes to collect data for the "Standard Check" test. The
results show "Conductivity Check Passed" in the "Status" area.

• If the sensor fails the conductivity check, refer to Clean sensor flow paths
on page 27 for details.

• When the flow path of the sensor has been flushed, fill with the appropriate
solution and push Start to do the conductivity check again.

7. Drain the solution in the flow path into a waste container.
8. To do another check with a different solution value:

a. Flush the sensor with DI water.
b. Flush the sensor with the next conductivity standard solution.
c. Fill the sensor with the next conductivity standard solution.

9. Push Next.
10. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

check information.
11. Push Next.

Verify sensor performance
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The software saves a .pdf report in the user-specified location on the PC.
12. Push Finish.

The Conductivity Check window closes and the report opens if the "View" box has a
check in it.

13. Install the pH sensor again if the sensor will be deployed within an hour or two.
14. Install the anti-fouling assembly again.

4.3 pH calibration

C A U T I O N
 

Wear latex gloves, a lab coat, and safety glasses. Wash hands after use.

Make sure that the pH values of the HydroCAT-EP agree to ±0.05 pH with the
manufacturer-supplied calibration values.
Supplies necessary to do the calibration:

• The manufacturer-supplied kit (P/N 50087.1) that includes the necessary plumbing
and tools

• 60 ml each of colorless buffers for pH calibration.
• 60 ml each of user-supplied conductivity standard solutions for conductivity

calibration.
• 500 ml bottle of DI water.
• Container for waste water.
• Container for the sensor.

Make sure that the sensor and the pH calibration buffers are at a stable temperature.
If necessary, remove the anti-fouling assembly from the sensor.
The general procedure for each calibration step:

1. Flush the sensor and tubing with DI water.
2. Flush the sensor and tubing with the appropriate calibration solution.
3. Fill the sensor with the appropriate solution and operate the sensor with the software

to measure the output: from the sensor Dashboard, push pH Calibration and do the
steps for each pH standard.

Refer to Conductivity standard check on page 19 for procedure to flush and fill the sensor
flow path.

Verify sensor performance

22



4.4 Optics check
Users that have the optional check cap can do the steps below to make sure that the
optical values of the HydroCAT-EP agree to within 20% of the manufacturer-supplied
calibration values of the sensor. Make sure that the temperature of the sensor is
18–26 °C or the optics check is not valid.

1. If necessary, remove the red protective cap from the optical face of the sensor so that
the optional check cap can be attached.

2. Make sure that the inside of the check cap is shiny, clean and dry and attached to the
optical face of the sensor. Refer to Maintain optical sensor on page 32 for details
about the maintenance of the optical face and the check cap.

3. To "pair" a new check cap with the optics:

a. Go to the Sensor menu, then HydroCAT-EP, Advanced, then Pair Optics Cal
Cap.

b. Enter the serial number of the new calibration cap, then push OK. The software
updates the reference values in the sensor.

c. Push OK to finish.
4. Do the steps below to do a check with a currently owned optical check cap.
5. Push Optics Check in the Dashboard area.
6. Push Next.
7. Push Start.

The software looks at the calibration values saved in the sensor. This will take
approximately 2 minutes.

8. If the sensor passes the optics check, go to step 10.
9. If the sensor fails the optics check:

• Make sure that the calibration cap is straight on the optical face and that the
index pin on the cap is in the notch on the sensor.

• Clean the optical face of the sensor and the orange glass of the cap.
• Do the optical check again.

10. Push Next.
The Create Optics Check Report window shows.

11. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

check information.
12. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
13. Push Finish.

The window closes and the report opens if the "View" box has a check in it.

Verify sensor performance
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Section 5 Make deployment setup selections

5.1 Set up sensor
Prepare the sensor for deployment, then use the software to make sure that the sensor
has the appropriate settings for the deployment.

1. Make sure that the hardware is prepared for deployment:

• Make sure that the batteries are installed and supply sufficient power for the
deployment. The nominal installed battery capacity is 7.8 Amp-hours (2.6 Amp-
hours × 3 parallel strings of batteries). Capacity is dependent on the
environmental conditions of a deployment. The manufacturer recommends a
value of 6.0 Amp-hours as a conservative estimate of capacity. The sensor will
stop operation if the voltage goes below 7.1 VDC for five consecutive samples.

• Make sure that the pH sensor is installed. Refer to Install or remove pH sensor
on page 30 for details.

• If necessary, remove the yellow protective label from the intake and exhaust
outlets.

• Make sure that the anti-fouling devices are installed and are sufficient for the
deployment. Refer to Remove or replace anti-fouling devices on page 28 for
details.

• Remove the red protective cap from the optical sensor.
2. Make sure that the bulkhead connectors on the sensor and the cable or dummy plug

are lubricated. Refer to Maintain bulkhead connector on page 35 for details.
3. Attach the cable or dummy plug to the sensor.
4. Make sure that the sensor is correctly attached to any mounting hardware.
5. If necessary, start the software and start communications with the sensor. If the

sensor is to be deployed with the connector end down, The manufacturer
recommends—

• For cabled deployments, operate the pump for 5–15 minutes to help clear any air
from the flow path.

• For non-cabled deployments deeper than approximately 30 m, let the sensor
operate for a day so that any air in the flow path dissolves and the pump primes
correctly.

• For deployments at which sediment is greater than 200 NTU, operate the sensor
connector-end down to reduce the quantity of sediment going to the intake area.

• Do not deploy the sensor in a horizontal orientation. Sediment collects in the
conductivity cell and the data will be of poor quality. If the sensor must be
deployed this way, mount it at a minimum of 10 degrees slope with the intake
above the exhaust.

6. Put the sensor in the water.

5.2 Set up data collection parameters
1. If necessary, make sure that the sensor is connected to the software. In the

Dashboard area, push "Deployment Wizard."
2. Deployment Setup step 1: Select "Autonomous Sampling," or "Polled Sampling"

(SDI-12 or RS232).
3. Push Next.
4. Deployment Setup step 2: For "Autonomous Sampling": Set the date and time to

start data collection. Then push Next.
Put a check in the box next to "Transmit Real Time" to see the data as it is collected
in a terminal program or a data controller. If the user does not put a check in the box,
the sensor still collects and saves data, but it does not show the data in real time.
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5. Deployment Setup step 3: For "Polled Sampling (SDI-12)": The manufacturer-set
default address is 0. Users can change this if necessary. Use the "Bad Data Flag"
default value of 9999999, then push Next.

6. Deployment Setup step 4: If necessary, change any of the settings in the Parameter
Units area and Parameters to Output.

7. Deployment Setup step 5: Enter the minimum conductivity frequency. Refer to the
section on Conductivity checks for details on this value.

• Fresh water deployment—add a 1 Hz offset to the zero conductivity value of the
sensor.

• Salt water deployment—add a 500 Hz offset to the zero conductivity value of the
sensor.

• Enter the "Pre-flush Duration" value. The minimum is 300 seconds.
8. Deployment Setup step 6: Put a check in the box to set the internal clock of the

sensor to the same time as the PC.

• Put a check in the box "Clear HydroCAT/EP data" to erase the data from the
internal memory of the sensor.

• If necessary, enter a pressure offset. If the sensor is deployed at sea level, enter
0.0 in the "Pressure Offset" area. The range is -3402823–3402823.

9. Deployment Setup step 7: Enter the time interval from 10–21600 seconds between
each sample for autonomous operation.
The calculated battery capacity and the number of 24-hour periods that the sensor
can operate is given as a reference. Note: The software calculates "Battery
Endurance" for new batteries only. Deployment time decreases for used batteries.

10. Push Next.
11. Deployment Setup step 8 (optional): make a Deployment Report.

• Enter the "Operator Name."
• Enter any text in the "Comments" area.
• Push Browse to change the location at which the report is saved on the PC.
• Put a check in the box next to "Overwrite if Existing" to save the new report only.

12. Push Finish. The sensor disconnects from the software.

• If the sensor was set up in a logger-controlled or "polled" mode, use the controller
unit to control the collection of data.

• If the sensor was set up in an autonomous mode and there is a check in the
"Transmit in Real Time" box from Step 2 of the Deployment Setup, start a
terminal program to monitor data in real time.

13. When the deployment is complete, connect to the software again and push Transfer
Data in the Dashboard to move the data that is saved in the sensor to the PC.

Make deployment setup selections
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Section 6 Maintenance

6.1 Clean sensor flow paths
Clean the sensor and the flow path at regular intervals so that the sensor continues to
collect accurate data.

C A U T I O N
 

Wear latex gloves, a lab coat, and safety glasses. Wash hands after use.

C A U T I O N
 

Do not use Triton® X-100 for long periods of time. Long exposure to Triton® X-100 causes
damage to the sensor membrane and changes the calibration of the sensor.

C A U T I O N
 

Never put undiluted Triton® X-100 or bleach into the sensor.

Supplies:

• plumbing kit, P/N 50087.1 
• 500 ml bottle of DI water
• container for waste water
• container for sensor.
• De-ionized or distilled water. If unavailable, use fresh tap water, used with Triton®

X-100 or bleach. Do not use shipboard fresh water because it can have traces of oil
in it.

• Triton® X-100 mixed 1000:1—The manufacturer supplies Triton® X-100 with each
sensor. Triton® X-100 is octyl phenol ethoxylate, a mild, non-ionic detergent. Make
sure that any alternative detergent that is used is scientific grade, with no colors,
perfumes, glycerins, lotions, etc.

• Bleach mixed 50:1—Household bleach is usually 4–7% (40,000–70,000 ppm) sodium
hypochlorite with stabilizers.

• Manufacturer-supplied CT-DO cleaning device.

Use warm 30 °C (86 °F) water and 1% Triton® X-100 to flush the flow path.
It may be necessary to do these steps up to five times to clean the flow path.
If there is bio-fouling on the sensor it may be necessary to fill the flow path with DI water
for approximately 12 hours to loosen debris.
Make sure to remove the anti-fouling assembly if necessary.

1. Attach a 10 cm length of tubing to either the intake or the exhaust port of the sensor.
2. Attach a length of tubing to the syringe.
3. Attach the syringe and tubing to either the intake or the exhaust port of the sensor.
4. Pull approximately 30 ml of cleaning solution into the syringe.
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5. Attach the syringe and tubing to either the intake or the exhaust port of the sensor.
6. Push the syringe plunger to fill the sensor until 3–5 cm of solution shows in each

tube.
7. Push and pull the plunger to mix the solution in the flow path. Do this 2–3 times.
8. Drain the solution from the sensor into a waste container. Push the syringe plunger to

help remove all of the solution from the sensor.

9. Use the syringe to flush the flow path with DI water.
10. If the flow path is still not clean, do steps 4–9 with the bleach solution.
11. Flush the flow path with DI water.

6.2 Remove or replace anti-fouling devices

W A R N I N G
 

AF24173 Anti-fouling devices contain bis(tributyltin) oxide. Wear rubber or latex gloves and eye
protection to replace these devices on the sensor. Wash hands with soap and water when
finished.
Read the precautions on the product label.
It is a violation of US federal law to use this product in a manner that is inconsistent with its label.

Remove the anti-fouling devices as a first maintenance task to save the anti-fouling
material for deployments.

Maintenance

28



1. Use a 5/32 hex wrench to loosen the two captured cap screws that attach the copper
anti-fouling assembly to the plastic assembly on the pressure housing. Carefully
remove the copper anti-fouling assembly from the housing.

2. Remove the three Phillips-head screws from the copper anti-fouling assembly, and
pull the copper guard off of the plastic anti-fouling holder.

3. Remove the Phillips-head screw that attaches the black anti-fouling cover, and
remove the cover.
The anti-fouling devices show.

4. Use a toothpick or similar to lift each of the anti-fouling devices out of the holder.

Option Procedure

To deploy sensor Insert new anti-fouling devices.
Attach the copper assembly to the sensor again.

To clean sensor Do not insert new anti-fouling devices.
Do not attach the copper assembly to the sensor again.

6.3 Clean pressure sensor

C A U T I O N
 

Do not put a brush or any object in the pressure port. It may damage or break the pressure
sensor.

Inspect and clean the pressure sensor annually.

1. Use a flathead screwdriver to remove the pressure port plug.

2. Flush the pressure port with warm DI water to remove any contamination.
3. Replace the pressure port plug. Do not over-tighten the nylon screw.

Maintenance
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6.4 Install or remove pH sensor
The pH sensor for the HydroCAT-EP ships separately in a white cap that is filled with potassium
chloride (KCl) solution to keep the glass bulb and reference electrode wet. The user must install
the pH sensor before the instrument is deployed to measure pH. Make sure to keep water and
dirt off of the connectors on the pH sensor.

1. Put a 3/32" hex key in the copper tube and loosen the screw that holds the pH sensor
or protective dummy connector (on new sensors) to the body of the HydroCat-EP.

2. Disconnect the pH sensor (or the dummy connector) from the main sensor body.
Keep the dummy connector.

3. Wet a lint-free swab with isopropyl alcohol and clean the connector area.

4. Use canned air to fully dry the connector area.
5. Make sure that the O-rings on the pH sensor are clean. Apply a light coat of silicone-

based Parker Super O Lube® to the installed O-rings.

Maintenance
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6. Make sure that the white cap is below the pH sensor.
The KCl solution will spill out of the white cap if it is turned upside down.

7. Use a 3/32" hex key to loosen the screw on the bottom of the white cap that attaches
to the pH sensor.

8. Remove the pH sensor from the white cap and install it onto the HydroCAT-EP body.
9. Install the 3/32" screw in the copper tube of the sensor again.

6.4.1 Replace reference junction
The manufacturer recommends that the reference junction in the pH sensor be replaced
every 3–4 months, or if data is unstable, slow, has "drift" or the pH sensor does not pass
the calibration check. Use the manufacturer-supplied pH reference junction kit to replace
the reference junction.
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6.5 Maintain pump
Sediment in the pump can cause data from the sensor to be of poor quality. To clean and
maintain the pump, put the sensor in clean water and operate the pump for 15 minutes.

6.6 Maintain optical sensor
Clean the face of the optical sensor and the optional check cap at regular intervals and
before calibration.

6.6.1 Clean optical face

1. After each deployment: flush the optical face with fresh water.

• If the optical face has visible contamination, use a small quantity of dish soap in
warm water to carefully clean the face, then flush with fresh water.

2. Clean the optical face with a lint-free, isopropyl alcohol-dampened cloth or tissue.
3. Clean the sensor within approximately 5 mm from the copper faceplate.

6.6.2 Replace wiper on optical face

C A U T I O N
 

Do not move the wiper by hand. It can damage the motor.

Maintenance
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Examine the wiper at regular intervals and replace the rubber wiper blade when it no
longer touches the optical face evenly, or if it is damaged.

1. Use a 3/32" hex key to loosen the 3/8" socket head cap screw in the wiper assembly
on the motor shaft.

2. Lift the wiper assembly straight off of the motor shaft.
3. Pull one end of the wiper blade to lift it out of the slot.

4. Put a small amount of isopropyl alcohol, dish soap, or water on the new wiper blade.
5. Push the larger "T"-shaped edge through the slot at an angle. It helps to compress

the wiper blade in one direction side-to-side so that it slides fully into the slot more
easily.

6. Push the wiper blade fully into the slot.

7. Carefully slide the wiper assembly back onto the motor shaft. Adjust the height so
that the wiper blade contacts the copper faceplate but does not bend. Orientation
does not matter.

8. Carefully hand-tighten the screw in the wiper assembly on the motor shaft.
When power is supplied to the sensor, the wiper will align to the closer of two points
on the copper faceplate.
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6.6.3 Clean optical sensor check cap
The check cap is optional equipment to check the calibration of the optical sensor.

1. Examine the check cap for dust, water spots, or other contamination.
It must be clean, dry, and shiny.

Clean check cap Dirty check cap

2. Soak a cotton swab with isopropyl alcohol.
3. Gently clean the glass to loosen or dissolve contamination.

4. While the glass is still wet, flush immediately with DI water to prevent a hazy film.
5. Dry the glass with a lint-free tissue (Kimwipe™ or equivalent).
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6. Blow the filter glass fully dry with Dust-Off® or dry nitrogen.
7. Replace the protective caps on each end if the check cap will not be used

immediately to check the calibration.

6.7 Maintain bulkhead connector

C A U T I O N
 

Do not use WD-40® or petroleum-based lubricants on bulkhead connectors. It will cause damage
to the rubber.
Damaged connectors can cause a loss of data and additional costs for service.
Damaged connectors can cause damage to the sensor and make it unserviceable.

Examine, clean, and lubricate bulkhead connectors at regular intervals. Connectors that
are not lubricated increase the damage to the rubber that seals the connector contacts.
The incorrect lubricant will cause the bulkhead connector to fail.

1. Apply isopropyl alcohol (IPA) as a spray or with a nylon brush or lint-free swab or
wipes to clean the contacts.

2. Flush with additional IPA.
3. Shake the socket ends and wipe the pins of the connectors to remove the IPA.
4. Blow air into the sockets and on the pins to make sure they are dry.
5. Use a flashlight and a magnifying glass to look for:

Cracks, scratches, or other damage on the
rubber pins or in the sockets.

Any corrosion.
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Separation of the rubber from the pins.

Swelled or bulging rubber pins.

6. Use a finger to put a small quantity (approximately 1 cm in diameter) of approved
silicone grease on the socket end of the connector and push as much of the lubricant
as possible into each socket. Approved silicone greases:

• Dow Corning Molykote® III Compound (DC III)
• Dow Corning High Vacuum Grease® (DC 976 V)
• Dow Corning 4 Electrical Insulating Compound® (DC 4)
• Dow Corning Molykote 44 High Temperature Grease (DC 44)

7. Connect the connectors.
8. Use a lint-free wipe to clean any unwanted lubricant from the sides of the connectors.

Maintenance
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Section 7 Software reference

7.1 Sensor dashboards
The dashboard is the main area from which to control and to communicate with the
sensor.
Information about the status of the sensor is contained in the upper part of the window
and is updated each time the sensor is connected to the software.
Common settings

• Start/Stop lets the user start and stop data collection.
• Sensor Settings lets the user select options for a specific deployment.
• Deployment Wizard lets the user select a deployment mode, start time, and the

parameters to measure, estimate the deployment time and data collection interval,
and make a summary report of the status of the sensor.

• Transfer Files, Data lets the user move data saved on the sensor to a PC.
• Replay Logged Data lets the user see data that was saved on a PC in a graph.
• Command Terminal lets the user send terminal program-level commands to the

sensor.
• Select Sensors lets the user select the parameters that show in the Time Series

graph.

Sensor-specific settings

• SUNA: Reference Update lets the user update the reference spectrum stored in the
sensor so that the sensor can accurately convert a spectral measurement into nitrate
concentration.

• SUNA: Wipe Now lets the user operate the anti-fouling wiper for one revolution.

• HydroCAT, HydroCAT-EP: Start Pumping operates the pump for 5 minutes if the
sensor is in water.

• HydroCAT, HydroCAT-EP: Conductivity Check lets the user verify that the
conductivity value that is output by the sensor is within specification.

• HydroCAT, HydroCAT-EP: Temperature Check lets the user enter reference
temperatures, collect data, and make new reference values..

• HydroCAT-EP: Optics Check lets the user verify that the optics values are within
specification.

• HydroCAT-EP: pH Calibration lets the user verify that the pH value is within
specification.

7.2 UCI menu
The user can set up the way the that the software saves information about the operation
of the sensor and change the way that the data looks from the Preferences menu.

7.2.1 General tab
• "Maximum Wakeup Attempts" lets the user select the number of times the software

will try to connect to a sensor. Range: 5–15.
• "Response Timeout" is the interval of time between communication between the

sensor and the software. Range: 5–10.
• "Default Data Directory" lets the user enter the location on the PC in which to save

data from the sensor. If there is a check in the "Prompt at startup" box, the user can
change the directory that the data is stored in every time the software starts.
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7.2.2 Display tab
Note: The software operates faster if the user selects less data and only one or two graphs.

Data that is collected by the sensor shows in the user-selected graphs in the
Performance Optimization Settings area of the Display tab.

• RS232 only: "Enable Real Time Display"—Put a check in this box to see the data as
it is collected in either the software, or if deployed, a terminal program.

• "Enable Time Series Graph"—Put a check in this box to see user-selected data.
Remove the check in the box to so that the graph is disabled and the data does not
show.

• SUNA only: "Enable Spectra Graph"—Put a check in this box to see both dark and
light data in raw counts.

• SUNA only: "Enable Total Absorbance Graph"—Put a check in this box to see the
calculated absorbance.

Time Series Settings—The default is a check in the box for continuous data collection
that is not limited to a specified amount of time. Remove the check in the box to enable
the "Time Axis Range Limit" of 60 minutes (default value). Only the most recent hour of
data will show in the Time Series Graph. The user-selectable range is 1–1440 minutes.

7.2.3 Message logging tab
The software automatically saves files that have information about sensor use, data
collection, and software operation over time. This information helps the user and
Customer Support find problems and do troubleshooting.

Software reference
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When the "Display Dialog for Error Level Messages" box has a check in it, the software
saves one of five levels of error messages.

• INFO—The default level. All high-level operations are saved.
• ERROR—Minimum level. Only errors that need to be examined by the user or

Customer Support are saved.
• WARN—Low level. The files that are saved do not have enough information for the

user to make an analysis of how the sensor is used and set up.
• DEBUG—High level. Used for troubleshooting. DEBUG and TRACE files are very

large.
• TRACE—The highest level. Used only for troubleshooting.

"Daily Log Files"—all messages from a single day are saved in one file.
"Rolling Log Files"—all messages are saved in one file until it is the maximum size
specified by the user. The messages are then saved to a new file. The user specifies the
number of files to keep. The oldest files are erased first.
"Enable Logging Lost Bytes"—if this box has a check in it, the software saves all of the
unexpected output from the sensor to a file.
"File Location"—the operating system of the PC determines where these files are saved.

7.3 Sensor menu
The Sensor menus have options for each sensor with which the software communicates.
Advanced Sensor menu items

• All: Set Clock lets the user "synchronize" the time between the PC and the sensor.

• SUNA: Edit Log Headers lets the user put labels on log files.
• SUNA: SUNA Self Test—the software does a test of the sensor function. The output

shows in the Instrument Console tab.
• SUNA: DAC Calibration does not apply to coastal deployments.
• SUNA: Upload Firmware File lets the user update the firmware in the sensor.
• SUNA: Administrative Settings is used only by the manufacturer.
• SUNA: Upload Instrument XML File is an .xml file necessary for the sensor to

process data. It is installed at C:\users\%username%\AppData\Roaming\Sea-
BirdScientific\UCI 1.2\SUNA_%SN%.xml.

• HydroCAT: Pressure Offset lets the user enter a value for the pressure offset of the
sensor. This value is also given the "Summary Report."
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• HydroCAT-EP: Pair Optics Cal Cap lets the user enter the serial number of a new
check cap to connect, or "pair" it with the sensor.

• HydroCAT, HydroCAT-EP: Delete Logged Data lets the user erase all of the data
saved in the sensor.

7.3.1 Make summary report
Get a summary of the settings saved in the sensor.

1. Select Summary Report.

2. Enter any comments about the report (optional).
3. Put a check in the "View Report" checkbox to see the report after it is created.
4. Push Browse to go to the directory in which to save the report.
5. Push Save Report.

The software makes a .pdf of the summary report.

7.3.2 Collect diagnostics
Use the diagnostic results to look at the current settings and commands sent to the
sensor that are saved as .log files. They are helpful for troubleshooting.

1. Go to the Sensor menu, select the connected HydroCAT, then select Collect
Diagnostics.

2. If necessary, push Browse to change the location on the PC to which the .zip file is
saved.

3. Push OK.
The Diagnostics Created window shows. Push OK to close the window.

4. Go to the .zip file on the PC and extract the files. There are three folders:

• console contains a summary of the operation, calibration, and device
configurations, and the event counter saved in the sensor.

• event log contains .log files useful for troubleshooting.
• reports contains the summary report referred to in Make summary report

on page 40.

7.3.3 Update firmware
Update the firmware for the sensor in the software program as necessary. The most
recent version is available on the manufacturer's website.

1. Go to the Sensor menu, select HydroCAT-EP, select Advanced, then select Upgrade
Firmware.

2. A Select Firmware File window shows.
3. Select the file with the .txt suffix.
4. Push Open.
5. The software updates the firmware in the sensor.
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This process will take several minutes. When process is complete, the software will
show the version and build of the new firmware installed in the sensor.

6. Push OK.

7.3.4 Pressure sensor offset
The user can change the pressure sensor offset to correct any linear offset error from
zero. Use a good quality barometer to determine the offset.

1. Let the sensor sit at a constant temperature for at least 5 hours.
2. Put the sensor in the orientation in which it will be deployed.
3. Turn on the sensor and connect to the software.
4. Make sure that the sensor is set up to collect pressure data.
5. Collect a minute or so of data.
6. Put the barometer at the same height as the pressure sensor port.
7. The offset is the difference between the barometer value and the pressure data from

the sensor.
8. Go to the Sensor menu, HydroCAT-EP, Advanced, then Pressure Offset.
9. Enter the value from step 7 in the Pressure Offset window of the software.

7.4 Data menu
The Data menu has sensor-specific options to look at data that has been saved to a PC.

7.4.1 Replay data

1. Go to the Data menu and select the applicable HydroCAT.
2. Push Replay Logged Data.
3. Select the data file to see.
4. Push Open.

The data shows in the Time Series graph.

7.4.2 Replay data from multiple sensors
The software lets the user replay data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to replay.

1. Go to the Data menu, then Replay Logged Data.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors for Display.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.
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7.5 View menu

Dashboards—Go to the View menu and Dashboards to select the dashboard for a
specific senor.
Graphs—Go to the View menu and select Time Series or SUNA > Spectra, Absorbance,
Reprocessed Nitrate.

• SUNA Spectra graph: the user can push Configure to change the number of graphs
to view. The "Graph History Limit" range is 1–2147483647. Put a check in the "Graph
History Unbounded" box to see the total number of graphs. Default value: no check in
the box and a "Graph History Limit" of 1.

• SUNA Absorbance graph: the user can change the "Min. Wavelength Cutoff" to
between 150–400 nm to change the scale of the graph. The user can push
Configure to change the number of graphs to view. The "Graph History Limit" range
is 1–2147483647. Put a check in the "Graph History Unbounded" box to see the total
number of graphs. Default value: no check in the box and a "Graph History Limit" of
1.

Output—Go to the View menu and select Instrument Console to see the data collected
by the sensor. Select Application Console to see terminal-level communications.
Instrument Console

Application Console

Real Time Data—Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Logging—Go to the View menu and select Data Logging to select the location on
the PC at which the collected data is saved.
Acquisition Monitor—Used by manufacturer for troubleshooting.
Message Log File—Used by manufacturer for troubleshooting.

7.6 Window and Help menus
The user can change how the software shows different tabs.
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• Close Current Window—closes the selected tab (highlighted in blue).
• Close all Windows—closes all tabs except the UCI Dashboard.
• Configure Window—

Maximize: increases the size of the selected tab to fill the software screen size.
Float: unlocks the selected tab from the software screen so that the user can move it
to other locations on the PC screen.
Float Groups: the same as Float above, but all tabs that are open are unlocked so
that the user can move them to other locations on the PC screen.
Minimize: minimizes the selected tab and moves it to the side of the software screen.
Minimize Group: minimizes the open tabs in the "Console," "Dashboard," or "Graph"
areas of the software.
Dock: locks the tab that the user selected to "float" back to its previous position in the
software window.
Dock Group: the same as Dock above, but all tabs that are open are locked back into
their previous position in the software window.

Go to the Help menu for help with sensor operation, settings in the software, and
troubleshooting. Select Sea-Bird Scientific to go to the manufacturer's web site.
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Section 8 Quick reference for SDI-12 and terminal
commands

8.1 SDI-12 commands and output
The sensor supports all basic SDI-12 commands. Refer to the SDI-12 specification at
www.sdi-12.org for details of the command protocol.

Converted decimal format for a C command

a+ttt.tttt+c+ppp.pppp+oo.ooo+p.pp+ff.fff+tt.ttt+sdf+sdt+sss.ssss+vvvv.vvv+x+ss.ss+v.v+n+flag

Index Description Format

1 SDI-12 address a

2 Temperature, °C or °F ttt.tttt

3 Conductivity c
S/m: cc.ccccc
mS/cm: ccc.cccc
µS/cm: ccccc.c

4 Pressure pppp.ppp

5 Oxygen, ml/L or mg/L oo.oo

6 pH p.pp

7 Fluorescence ff.fff

8 Turbidity tt.ttt

9 Fluorescence standard deviation, µg/L sdf

10 Turbidity standard deviation, NTU sdt

11 Salinity, psu sss.ssss

12 Sound velocity, m/sec vvvv.vvv

13 Specific conductivity x
S/m: xx.xxxxx
mS/cm: xxx.xxxx
µS/cm: xxxxx.x

14 Percent oxygen saturation ss.ss

15 Main power supply voltage, internal or external, as applicable v.v

16 Sample number in flash memory (value is -1 if the polled
sample setup does not store data)

n

17 Error flag 0 = good
1= low battery
2 = did not take 30 fluorescence-turbidity
measurements
4 = fluorescence-turbidity wiper position error
8 = oxygen sensor error
16 = fluorescence-turbidity not sampled
32 = pump stalled
64 = pH not sampled
xx = __ (for example, xx=65 is 1 [low battery] +
64 [pH not sampled])

Converted decimal format for an M command
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a+ttt.tttt+ppp.pppp+oo.ooo+p.pp+ff.fff+tt.ttt+x+ss.ss+v.v

Index Description Format

1 SDI-12 address a

2 Temperature, °C or °F ttt.tttt

3 Pressure pppp.ppp

4 Oxygen, ml/L or mg/L oo.oo

5 pH p.pp

6 Fluorescence ff.fff

7 Turbidity tt.ttt

8 Specific conductivity x
S/m: xx.xxxxx
mS/cm: xxx.xxxx
µS/cm: xxxxx.x

9 Percent oxygen saturation ss.ss

10 Main power supply voltage, internal or external, as applicable v.v

Definitions

• a = SDI-12 address of the sensor.
• 1l = SDI-12 version compatibility.
• Vendor ID = 8 characters.
• <CR> = Carriage Return character.
• <LF> = Line Feed character.

Example: a sensor set to address 0, serial number 32345, firmware version 5.0.0.
The SDI-12 recorder sends aI!
The sensor sends 013SeaBird HCEP 50032345 <CR><LF>

Break

Response None; start search for valid mark

Purpose 12 ms spacing on the line: wake all HydorCAT-EPs on line. (! command termination and
<CR><LF> do not apply)

Acknowledge Active = a!

Response a<CR><LF>

Purpose verifies communication with sensor

Send identification = aI!

Response allccccccccmmmmmmvvvnnnnnoooooooo<CR><LF>

a = sensor address

Il (lowercase "L") = 2-character SDI-12 version. For example, "13" for version 1.3 

cccccccc = 8-character manufacturer identification. For example, "SeaBird"

mmmmmm = 6-character sensor model. For example, "HCEP"

vvv = 3-character firmware version. For example, "500"

_nnnnnn = up to 6-character serial number field.
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optional sensors. Up to 8 characters. P = pressure, O = DO, FN = chlorophyll and turbidity

Example address = 0. serial number = 32345. The firmware version is 5.0.0 

recorder sends 0I!

sensor sends 013SeaBird HCEP 50032345POFN<CR><LF>

Address query = ?!

Response a<CR><LF>

Purpose shows the sensor's SDI-12 address

Change address = aAb!

Response b<CR><LF>

Purpose changes the sensor's SDI-12 address to "b". The default address is 0.

Example address = 0 

recorder sends 0A1!

sensor sends 1<CR><LF>

address now = 1 

Measurement commands

Start Measurement = aM!
Start Measurement and Request CRC (aMC!)
Start Concurrent Measurement = aC!
Start Concurrent Measurement and Request CRC (aCC!)

Response atttnn<CR><LF>
a<CR><LF>

Purpose Send TPSS to sensor to operate the pump, take a measurement, store the data in flash memory.

Start Measurement = aM1!
Start Measurement and Request CRC (aMC1!)
Start Concurrent Measurement = aC1!
Start Concurrent Measurement and Request CRC (aCC1!)

Response atttnn<CR><LF>
a<CR><LF>

Purpose Send TPS to sensor to operate the pump, take a measurement, store the data in buffer until the next
measurement.

Start Measurement = aM2!
Start Measurement and Request CRC (aMC2!)
Start Concurrent Measurement = aC2!
Start Concurrent Measurement and Request CRC (aCC2!)

Response atttnn<CR><LF>
a<CR><LF>

Purpose Send TS to sensor to take a measurement, store the data in buffer until the next measurement. Pump
does not operate before measurement.

Data output from an aM! or aMC! command
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Send Data = aD0!–aD1!

Response a<values><CR><LF> or a<values><CRC><CR><LF>

Purpose sends data to the SDI-12 recorder

Notes aD0! after aM! or aMC!

35 characters are allowed. The response is the first 6 values in the SDI-12 data format in response to
an aM! Command. If a subsequent aD1! command is sent, the sensor will send the remaining values.

Sample of data output from an aM! command

0M!00449<CR><LF>

0<CR><LF>

0D0!0+23.4679-0.085+8.057+7.5 -0.104<CR><LF>
0D1!0+3.504+0.0009+95.03+13.8<CR><LF>

SDI-12 address + temperature + pressure + oxygen + pH + fluorescence + turbidity + specific conductivity + percent oxygen
saturation + voltage from main power supply

Data output from an aC! or aCC! command

Send Data = aD0!–aD1!–aD2!

Response a<values><CR><LF> or a<values><CRC><CR><LF>

Purpose sends data to the SDI-12 recorder

Notes aD0! after aC!

75 characters are allowed. There is space in the 75-character field for 12 values. The recorder needs to
send an aD1! command to get the remaining values.

Sample of data output from an aC! command

0C!004416<CR><LF>

0D0!0+23.4563+0.005-0.084+8.054+7.75-0.097+3.409+1.14+0.55+0.0113+1492.497<CR><LF>
0D1!0+0.006+95.00+13.8+1+0<CR><LF>

SDI-12 address + temperature + conductivity + pressure + oxygen + pH + fluorescence + turbidity + fluorescence standard
deviation + turbidity standard deviation + salinity + sound velocity + specific conductivity + percent oxygen saturation +
voltage from main power supply + sample number + error flag

SDI-12 extended commands

aXV!

Response av.v.v, mm dd yyyy hh:mm:ss<CR><LF>

Purpose Get full sensor firmware version string, where:
a = SDI-12 address, v.v.v = firmware version, mm dd yyy hh:mm:ss = date and time of firmware version

aXPx!

Response ax<CR><LF>

Purpose Sends PumpOn=1 PumpOff=0. Operate pump to test or to remove sediment. The pump operates
continuously. Pump stops after 2 minutes with no communication or if PumpOff is sent.
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aXMCFx!

Response ax<CR><LF>

Purpose Send MinCondFreq=x. Range = 0–5000. The minimum conductivity frequency for pump to operate, so
that the pump does not operate in air.

aXMR0!

Response n<CR><LF> Send twice to stop accidental reset of memory.
First command shows the current number of samples in memory.
Second command shows the number of samples reset to 0.

Purpose Send InitLogging. If this command is not sent, data is stored after the last sample.

aXUTx!

Response ax<CR><LF>

Purpose Send SetTempUnits=x. x=0 for °C, x=1 for °F

aXUCx!

Response ax<CR><LF>

Purpose Send SetCondUnits=x. x=0 for conductivity in S/m
x=1 for mS/cm
x=2 for µS/cm

aXUPx!

Response ax<CR><LF>

Purpose Send SetPressUnits=x. x=0 for pressure in decibars
x=1 for psi

aXUOx!

Response ax<CR><LF>

Purpose Send SetOxUnits=x.
x=0 for oxygen in ml/L
x=1 for mg/L

8.2 Summary of terminal commands
This is a reference for advanced users. The values of these commands are stored in the
sensor until the user changes them. Notes about terminal commands are listed below.

• Commands are not case-sensitive. Use "Enter" to store a command.
• The sensor sends an error message if a command is invalid.
• The argument Y and 1 are both "Yes" and N and 0 are both "No." For example,

OutputSal=y and OutputSal=1 are equivalent.
• If there is no communication with the sensor for 2 minutes, it goes into a low power

mode. Use "Enter" to start communication again.
• Use the "Esc" key or type ^C, then "Enter" to stop the sensor as it sends data.
• If the user sent StartNow (autonomous mode) and the sensor is in operation or in

standby, the user can use the Status commands, TS, TPS, SL, QS, and Stop. For
example, if the user sends a DS to see status data, the sensor completes the current
measurement and then responds to the command. If OutputExecuted=Y, the sensor
will send "executing" messages until the measurement is complete.
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• If the user sent StartLater (autonomous mode) and the sensor is operation or in
standby, the user can use the Status commands, TS, TPS, SL, QS, and Stop. To
send other commands, enter the Stop command, then enter any other commands,
and send StartLater again.

Status

GetCD show configuration

GetSD show status

GetCC show calibration coefficients

GetEC show event counter

Reset EC reset event counter

GetHD show hardware

Help shows list of available commands

DS show status and configuration

DC show calibration coefficients

pHCalHist show pH sensor calibration history related to stored data

General setup

DateTime=x set clock. format is mmddyyyhhmmss

BaudRate=x RS232 rates. Default is 19200. 600*, 1200*, 2400*, 4800, 9600, 19200, 38400, 57600, 115200.
*available only if no oxygen sensor is not installed.

ReferencePressure=x reference pressure, gauge, dbar for conductivity, specific conductivity, oxygen, salinity, sound
velocity calculations if a pressure sensor is installed.

*default reset most user-input settings to manufacturer's default.

ReSync update sensor with latest information from DO, fluorometer-turbidity, and pH sensors.

QS puts sensor in low power ("quiescent") state. Sensor continues to take measurements and
store data.

RS232 setup

OutputExecutedTag=x Y: show executing and executed XML tags. N: do not

TXRealTime=x Y: send data in real-time. N: do not

SDI-12 setup

SetAddress=x address can be 0–9, a–z (either case). Send command twice.

SetSDI12Flag=x out-of-range value, -9999999 to +9999999 (include + or -) for OutputFormat=3. Default is
+9999999. If the sensor calculates out-of-range data for a parameter, this value is included in
the data output.

Pump setup
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MinCondFreq=x Minimum Conductivity Frequency for pump to
operate, Hz

PreFlush=x time, seconds, for pump to operate before the first
measurement. Default is 300. Range 300–600.
If autonomous operation starts with StartNow, the
pre-flush starts immediately.
If autonomous operation starts with StartLater, the
pre-flush starts x seconds before scheduled start
time.

PreFlushStartTIme=x set mmddyyyyhhmmss for controlled ("polled")
data collection.
set 0 to disable the pre-flush for controlled data
collection.

OxNTau=x pump operation time multiplier. Default is 7.0.
Range 0–100.0.

PumpTime=x time the pump operates for each measurement,
when oxygen sensor is installed. Range 0–550.

PumpOn start pump. Pump will stop after 2 minutes without
communication or when PumpOff is sent.

PumpOff stop pump, if started with PumpOn.

DO sensor setup

Send63:command sensor sends command to DO sensor and gets response.

other commands refer to the SBE 63 manual for command list. Required commands:
SetEcho=1, SetFormat=1, SetAvg=2 (range 1–16), SetAutoRun=0.

Fluorometer-turbidity sensor setup

GetOpticsRef get stored check cap reference values from the last calibration.

SetOpticsRef set check cap reference values. Sensor sends 6 measurement values, fluorescence then
turbidity, at gain settings of 1, 5, and 25, plus calibration date and serial number of check cap.

Memory setup

InitLogging make all of the memory available and erase pH calibration history. Command must be sent
twice.

RecoverSamples Put the pointer at the last measurement in memory and restore pH sensor calibration history.
Command must be sent twice.

Output format setup
Commands for parameters apply only if the user selects OutputFormat=1, 2, or 3. Output format commands are ignored if x=0.
Where x=N, that parameter is not part of the output.

OutputFormat=x x=0: raw decimal data
x=1: converted decimal data
x=2: converted decimal data in XML
x=3: converted decimal data in SDI-12 format

OutputTemp=x x=Y: output temperature
x=N: do not

SetTempUnits=x x=0: temperature, °C

OutputCond=x x=Y: output conductivity
x=N: do not
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SetCondUnits=x x=0: conductivity and specific conductivity, S/m
x=1: conductivity and specific conductivity, mS/cm
x=2: conductivity and specific conductivity, µS/cm

OutputPress=x x=Y: output pressure, if so equipped
x=N: do not

SetPressUnits=x x=0: pressure, decibars
x=1: pressure, psi (gauge)

OutputOx=x x=Y: output oxygen, if so equipped
x=N: do not

SetOxUnits=x x=0: oxygen, ml/L
x=1: oxygen, mg/L

OutputpH=x x=Y: output pH
x=N: do not

OutputFl=x x=Y: output fluorescence, µg/L
x=N: do not

OutputTbd=x x=Y: output turbidity, NTU
x=N: do not

OutputSal=x x=Y: output calculated salinity, psu
x=N: do not

OutputSV=x x=Y: output calculated sound velocity, m/sec
x=N: do not

OutputSC=x x=Y: output calculated specific conductivity
x=N: do not

UseSCDefault=x only applies if OutputSC =Y
x=0: do not use default. Use SetSCA=(see SetSCA below)
x=1: use default of 0.20 to calculate thermal coefficient of conductivity for natural salt ion solutions.

SetSCA=x only applies if OutputSC=Y and UseSCDefault=0 
x= calculated thermal coefficient of conductivity for natural salt ion solutions

OutputOxSat=x x=Y: outputcalculated oxygen saturation, %
x=N: do not

TxSampleNum=x X=Y: output sample number with real-time data or
sample number under controlled ("polled") data stored to memory.
x=N: do not

Autonomous data collection

SampleInterval=x x=time interval between sample measurements. Range 10–21600.
The user must set SampleInterval to the pump operation time + 38 seconds when the fluorometer-
turbidity sensor is installed. If this sensor is not installed, SampleInterval can be the pump operation
time + 8 seconds.

StartNow start sensor

StartDateTime mmddyyyyhhmmss for delayed start

StartLater start sensor at a delayed start time

Stop stop sensor or delayed start time. Sensor must be stopped before data is transferred.

Logger-controlled "polled" data collection

TS Pump does not operate. Take sample, store data in buffer, send data.

TPS Pump operates. Take sample, store data in buffer, send data.
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TPSS Pump operates. Take sample, store data in buffer and in flash memory, send data.

TSN:x Pump does not operate. Take x samples (1–100), send data.

SL Send the last sample in the buffer.

TempCheck:x Pump operates continuously while sensor takes x samples and sends data. Temperature sensor is
verified. Values for pH, oxygen, oxygen saturation, fluorescence and turbidity are not valid.

CondCheck:x Pump operates continuously while sensor takes x samples and sends data. Conductivity sensor is
verified. Values for pH, oxygen, oxygen saturation, fluorescence and turbidity are not valid.

T63 Pump does not operate. DO sensor sends oxygen data in the format set with the SetFormat= in
SBE63.

TOptics Pump does not operate. Fluorescence and turbidity sensor sends 1 set of 30 measurements in the
format set with the SetFormat= in HCO.

OpticsStats Sends the average and standard deviation results of the TOptics command.

Data upload
Make sure to send a Stop command before a GetSamples command.

GetSamples:b,e Upload scan b to e in the format set with the OutputFormat= command. A maximum of
5000 samples can be uploaded at one time.

Coefficients
Where F = floating point number. S = string with no spaces. Date = date of calibration.
Calibration coefficients are set by the manufacturer and are the same as those shown on the Calibration Certificates that come
with the sensor. Use GetCC or DC to see calibration coefficients stored in the sensor.

TDalDate=S date of temperature calibration

TA0=F temperature A0 

TA1=F temperature A1 

TA2=F temperature A2 

TA3=F temperature A3 

CCalDate=S date of conductivity calibration

CG=F conductivity G

CH=F conductivity H

CI=F conductivity I

CJ=F conductivity J

WBOTC=F conductivity wbotc

CTCor=F conductivity ctcor

CPCor=F conductivity cpcor

CZ=F zero conductivity frequency, Hz

PCalDate=S date of pressure calibration

PA0=F pressure A0 

PA1=F pressure A1 

PA2=F pressure A2 

PTCA0=F pressure ptca0 

PTCA1=F pressure ptca1 

PTCA2=F pressure ptca2 
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PTCB0=F pressure ptcb0 

PTCB1=F pressure ptcb1 

PTCB2=F pressure ptcb2 

PTempA0=F pressure temperature a0 

PTempA1=F pressure temperature a1 

PTempA2=F pressure temperature a2 

POffset=F pressure offset, decibars
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Section 9 Troubleshooting

Possible problem Possible solution

Cannot communicate with
sensor

• Close the software, turn the power supply to the sensor off and disconnect the
communication connector at the PC. Turn the power supply back on, connect the
communication cable to the PC and start the software. Push Connect to start
communication again. Make sure that there is a check in the "try all baud rates" box.

• Make sure that the PC-sensor cable is connected correctly.
• Verify that the battery pack is installed.

Sensor does not save collected
data

• Make sure that the memory is not full. If it is, save the data to a PC, then erase the
data stored in the sensor.

Zero conductivity check fails • Flush the sensor with DI water.
• Make sure to remove ALL water from the flow path and the conductivity cell.
• HydroCAT: Make sure that the value on the conductivity certificate is entered correctly

in the software.
• HydroCAT-EP: make sure that the value on the conductivity certificate is the same as

the value stored in the sensor: enter "GetCC" in the terminal command area of the
software. Look for the "<Z>" value.

Optics calibration check fails • Make sure that the calibration check cap is installed correctly. The cap should be
straight, with the pin on the cap in the notch on the sensor.

• Clean the optical face.
• Make sure that the calibration cap is clean. Examine the orange glass for dust, water

spots, or other contamination. Clean if necessary.

pH calibration fails • Make sure that the standard solutions are not expired.
• Make sure that the standard solutions, the DI water and the sensor are at the same

temperature.
• Make sure that the probe is moist. If it is dry, fill the soaker cap with pH 4 standard

and soak the probe for 24 hours.
• If the pH output values are A) unstable, slow, or "drift," or B) the sensor cannot be

calibrated, refer to the section about pH sensor maintenance for details about how to
replace the electrolytes and Teflon™ junction.

Data is unreasonable • Verify that the calibration coefficients are correct.
• Make sure that the pump operates correctly.

Salinity data is out-of-spec • Clean the sensor.
• At shallow depths, air bubbles can cause the conductivity cell measurements to be

incorrect.

Wiper does not operate correctly • Examine and adjust the height of the blade to the optics face. It should just touch the
optical face.
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Section 10 General information

Revised editions of this user manual are on the manufacturer's website.

10.1 Delivered items
P/N Description Qty

171498.1 Dummy connector and lock collar 1 ea

802220 I/O cable, 2.4 m 1 

50441 Size AA Saft lithium batteries 12 

801863 Battery holder for lithium batteries 1 

30411 Triton-X cleaning solution for conductivity cell 1 

801542 Anti-fouling device, (bis)tributyltin oxide 2 

50640 Syringe and tubing kit for cleaning sensor flow path 1 

— CD with user manual, software, calibration information 1 

pH sensor in white HDPE holder with KCl solution 1 

013410HY pH reference junction refill kit

• O-ring for Teflon™ junction
• Teflon™ junction
• syringe
• flat blade screwdriver
• KCl salt pellets
• 100 ml reference solution of saturated KCl and AgCl

1 

BAA-542041 Wiper blade for optical sensor 1 

GXA-ZX0656 Red vinyl protective end cap, 1.75" for optical sensor 1 

60074 Hardware kit

• 30097, O-ring 2-111, exhaust to cell guard seal
• 30498, O-ring 2-110, anti-fouling cartridge seal
• 30857, O-ring 2-033, connector end flange
• 30858, O-ring 2-133, battery pack end cap
• 31322, O-ring 2-130, battery pack housing
• 31513, socket head cap screw, titanium, 8-32 x 5/8", sensor lift eye
• 31755, socket head cap screw, titanium, 8-32 x ¼", connector end flange to pressure

housing
• 30844, flat head Phillips screw, titanium, 10-32 x 3/8" cell guard
• 31811, flat head Phillips machine screw, 10-24 x 7/8" anti-fouling cover
• 30174, pan head stainless steel machine screw, 10-24 x 9/16" anti-fouling cover
• 31670, hex key, 3/32" long arm, for pH module
• 31671, hex key, 5/32" long arm, for copper anti-fouling assembly
• 31749, hex key, 7/64" long arm, for battery pack
• 31516, hex key, 9/64" long arm, for connector end flange
• 31478, washer shoulder, #8, anti-fouling cover retaining screw insulator
• 311521, removable shipping sticker to keep dirt out of conductivity cell

1 

SAS-542035 If purchased, check cap for optical sensor 1 

GXA-ZX0678 Red vinyl protective end cap, 1.875" for check cap 1 

GXA-ZX0679 Black vinyl protective end cap, 1.25" for check cap 1 
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10.2 Shipping lithium batteries

C A U T I O N
 

Do not ship the sensor with the batteries installed. Do not ship the battery pack for the sensor with
the batteries installed.

The information below is general, for guidance only to appropriately trained shipping
personnel. Refer to the IATA Dangerous Goods Regulations for complete information
about shipping lithium batteries.
The manufacturer ships the lithium cells with the sensor in a separate box. Each of the
12 cells is packed in heat-sealed plastic. All batteries are packed in bubble wrap in a
sturdy box.

Batteries that are shipped without the sensor are Dangerous Goods. They can only be
shipped by personnel with the appropriate training from an organization that has a
Dangerous Goods program.

Sensor, no spares Sensor, 1 or 2 spare cell sets Cells only

UN # 3091 3090 

PI # 969 968 

Passenger aircraft yes no

Cargo aircraft yes

Label requirements

--
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10.3 AF24173 anti-fouling device

D A N G E R
 

Refer to the Precautionary Statements for additional information.

For use only in Sea-Bird Electronics' conductivity sensors to control the growth of
aquatic organisms within electronic conductivity sensors.
Replacement AF24173 Anti-fouling devices are supplied in polyethylene bags that have
the label shown below.

First Aid

If on skin or
clothes:

Remove contaminated clothes.

Rinse skin immediately with plenty of water for 15–20 min.

Call a poison control center or a doctor for treatment advice.

If swallowed: Call a poison control center or a doctor immediately for treatment advice.

Have person drink several glasses of water.

Do not induce vomiting.

Do not give anything by mouth to an unconscious person.

If in eyes: Hold the eye open and rinse slowly and gently with water for 15–20 min.

Remove contact lenses, if present, after the first 5 minutes, then continue to rinse eye.

Call a poison control center or a doctor for treatment advice.

Note to physician: Probable mucosal damage may contraindicate the use of gastric
lavage.
Refer to the product container or label when a poison control center or physician is called,
or going for treatment. For more information, call the National Pesticide
Telecommunications Network at (NPTN) at 1-800-858-7378.
Net contents: Two anti-foulant devices
Sea-Bird Electronics, Inc.
13431 NE 20th St.
Bellevue, WA 98005 
EPA Registration No. 74489-1 
EPA Establishment No. 74489-WA-1 
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PRECAUTIONARY STATEMENTS
HAZARD TO HUMANS AND DOMESTIC ANIMALS

D A N G E R
 

Corrosive—Causes irreversible eye damage and skin burns. Harmful if swallowed. Harmful if
absorbed through the skin or inhaled. Prolonged or frequently repeated contact may cause allergic
reactions in some individuals. Wash thoroughly with soap and water after handling.

USER SAFETY RECOMMENDATIONS FOR PERSONAL PROTECTIVE EQUIPMENT
(PPE)
Users should:

• Remove clothes immediately if pesticide gets inside. Then wash thoroughly and put
on clean clothes.

• Wear protective gloves (rubber or latex), goggles or other eye protection, and clothes
to minimize contact.

• Follow the manufacturer's instructions to clean and maintain PPE. If there are no
such instructions for washables, use detergent and hot water. Keep and wash PPE
separately from other laundry.

• Wash hands with soap and water before eating, drinking, chewing gum, using
tobacco or using the toilet.

ENVIRONMENTAL HAZARDS
Do not discharge effluent that contains this product into lakes, streams, ponds, estuaries,
oceans, or other waters unless in accordance with the requirements of a National
Pollutant Discharge Elimination System (NPDES) permit and the permitting authority has
been notified in writing prior to discharge. Do not discharge effluent that contains this
product to sewer systems without previously notifying the local sewage treatment plant
authority. Contact the local State Water Board or Regional Office of the EPA for
guidance. This material is toxic to fish. Do not contaminate water to clean equipment or
dispose of equipment washwater.
PHYSICAL OR CHEMICAL HAZARDS
Do not use or store near heat or open flame. Avoid contact with acids and oxidizers.
DIRECTIONS FOR USE
It is a violation of Federal Law to use this product in a manner inconsistent with its
labeling. For use only in Sea-Bird Electronics' conductivity sensors. Read installation
instructions in Remove or replace anti-fouling devices on page 28.
STORAGE AND DISPOSAL
PESTICIDE STORAGE: Store in original container in a cool, dry place. Prevent exposure
to heat or flame. Do not store near acids or oxidizers. Keep container tightly closed.
PESTICIDE SPILL PROCEDURE: In case of a spill, absorb spills with absorbent material.
Put saturated absorbent material into a labeled container for treatment or disposal.
PESTICIDE DISPOSAL: Pesticide that cannot be used according to label instructions
must be disposed of according to Federal or approved State procedures under Subtitle C
of the Resource Conservation and Recovery Act (RCRA).
CONTAINER HANDLING: The container may not be used again. Do not reuse this
container for any other purpose. Offer to recycle if available.

10.4 Service and support
The manufacturer recommends that sensors be sent back to the manufacturer annually to
be cleaned, calibrated, and for standard maintenance.
Refer to the website for FAQs and technical notes, or contact the manufacturer for
support at support@seabird.com.
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Do the steps below to send a sensor back to the manufacturer.

1. Complete the online Return Merchandise Authorization (RMA) form or contact the
manufacturer.
Note: The manufacturer is not responsible for damage to the sensor during return shipment.

2. Remove all batteries from the sensor.
3. Remove all anti-fouling treatments and devices.

Note: The manufacturer will not accept sensors that have been treated with anti-fouling
compounds for service or repair. This includes AF 24173 devices, tri-butyl tin, marine anti-
fouling paint, ablative coatings, etc.

4. Use the sensor's original ruggedized shipping case to send the sensor back to the
manufacturer.

5. Write the RMA number on the outside of the shipping case and on the packing list.
6. Use 3rd-day air to ship the sensor back to the manufacturer. Do not use ground

shipping.
7. The manufacturer will supply all replacement parts and labor and pay to send the

sensor back to the user via 3rd-day air shipping.

10.5 Waste electrical and electronic equipment
Electrical equipment that is marked with this symbol may not be disposed of in European public
disposal systems. In conformity with EU Directive 2002/96/EC, European electrical equipment
users must return old or end-of-life equipment to the manufacturer for disposal at no charge to
the user. To recycle, please contact the manufacturer for instructions on how to return end-of-
life equipment, manufacturer-supplied electrical accessories, and auxiliary items for proper
disposal.
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Sea-Bird Electronics
13431 NE 20th Street
Bellevue WA 98005 U.S.A.
(425) 643-9866

© Sea-Bird Electronics, Inc., 2017. All rights reserved. Printed in USA. 
*HydroCAT-EP170727*
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